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Introduction

This book is designed for new users of Cabri Jr. The activities provide the basic steps of using the drawing and measurement tools of the 

application within the context of familiar geometry concepts. The total time indicated at the top of the page includes fi ve minutes for introduction 

and vocabulary review and fi ve minutes to summarize the activity. Many of the activities include TI-Navigator™ extensions which are indicated 

by a TI-Navigator icon.

These 25 fundamental explorations use Cabri Jr. tools to help make and support conjectures. Hopefully, the experience of working through 

these activities will serve as a springboard for learning more about Cabri Jr. as a tool for deeper investigations using the richness of 

construction and proof. 

Before beginning the activities, it is suggested that new users familiarize themselves with the fundamentals of Cabri Jr. by working through 

Cabri Jr. Basics, which are the fi ve basic activities found at the back of the book.

The NCTM Standards are listed with the permission of the National Council of Teachers for Mathematics (NCTM), 

www.nctm.org. NCTM does not endorse the content or validity of these alignments.

About the Author

Ruth Casey is a mathematics teacher in Lawrenceburg, Kentucky, where she teaches Algebra 2, Geometry, Data & Measurement and also 

serves as department chair. She received her undergraduate degree in mathematics from the University of Kentucky and her Masters’ Degree 

in secondary education from Georgetown College. She is a National Board Certifi ed Teacher in Adolescent and Young Adult Mathematics. 

About to complete her 29th year teaching in public schools, Ruth has taught many levels of mathematics from eighth grade math through 

Calculus. She lives in Frankfort, Kentucky with her husband Kerry, a National Board Certifi ed physics teacher, and 19 year-old son Brian who 

have given their unwavering support over the years as her involvement in education has taken her beyond the classroom. 

Ruth is a National Instructor for Teachers Teaching with Technology (T3™) and her role as a leader in professional development has offered 

many opportunities to work with teachers at the local, state, and national level. She has received the Presidential Award for Excellence in the 

Teaching of Mathematics, been recognized as a Tandy Scholar, and was chosen as a Christa McAuliffe Fellow. She was selected as a recipient 

of the 2004 Leadership Award from the T3 program.  

She has been on the development team for T3 materials and was an author for the Glencoe / McGraw-Hill Algebra 1 and Algebra 2 books. Ruth 

is a frequent speaker at national, regional, and state conferences and institutes on the use of technology as a tool for teaching and learning 

mathematics. She is currently serving on the Teacher Advisory Council of the National Academy of Sciences and is a member of the Board of 

Directors for the National Council of Teachers of Mathematics.

Getting Started With Cabri™ Jr.
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for the F2 menu. Move 
to Segment and press e to 
activate the segment drawing tool.

3 

Move the pencil to the desired location 
of one endpoint and press e. 
Move to the other endpoint of the 
segment and press e.

Press C to exit the Segment 
drawing tool.

4 

Move the cursor until the segment is 
dashed and fl ashing then press # 
for F3 and move down to Midpoint 
and press e.

5 

Press e again to mark the 
midpoint.

Press C to exit the Midpoint 
drawing tool.

6 

Press % for F5 and move down to 
Measure and right to D. & Length.

Press e.

7 

Move until the midpoint is fl ashing then 
press e.

Move the pencil to an endpoint, and 
when it is also fl ashing, press e. 
The distance from the midpoint to 
the endpoint is displayed. The hand 
indicates that the measurement can be 
moved. Use the arrow keys to move 
it to a convenient location, and then 
press C to turn off the hand.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a segment
• Find the midpoint
• Measure the segment and each half
• Change the length

This activity allows us to review the basic geometry defi nitions of segment and midpoint, while learning 
to use drawing and measurement tools. We can then explore changes in measurements as we alter the fi gure.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional 
geometric shapes and develop mathematical arguments about geometric relationships.

Midpoint of a SegmentApproximate
Total Time:
25 minutes
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8 

The measurement tool is still active 
so return the pencil until the midpoint 
is fl ashing. Press e then move 
until the other endpoint fl ashes and 
press e. Move the measurement 
to a convenient location away from 
the segment. Press C to turn 
off the hand and C to exit the 
measurement tool.

9 

Use the arrow keys to move until one 
endpoint is fl ashing, press a to 
activate the hand. Use :;<> to 
change the location of the endpoint of 
the segment. Since the midpoint has 
been marked, the measurements will 
change as the segment changes.

For TI-NavigatorTM Users

Use Screen Capture to observe and 
assess individual progress in drawing 
and exploring. For help, see page 56.

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Midpoint of a Segment
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 
Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for the F2, move to 
Segment, and press e. Move 
to the right and mark an endpoint by 
pressing e. Now move left and 
mark another endpoint by pressing 
e again. This point will be the 
vertex of the angle so press e to 
start a new segment with the same 
endpoint. Move up and right to end the 
segment with e. You should have 
two segments with a common endpoint.

3 

Press % for F5 and move to 
Measure and Angle. Press e. You 
will now select 3 points to determine the 
angle. As in naming angles, the second 
point selected is the vertex of the angle.

For TI-NavigatorTM Users

Use Quick Poll to review naming 
& measuring angles (e.g. What is 
the vertex of angle ABC? Give the 
measure of an angle which is obtuse.). 
For help, see page 59.

4 

Move to last endpoint you marked, 
and when it is fl ashing, press e 
to choose that point. Move until the 
vertex of the angle is fl ashing and 
press e. The third point defi ning 
the angle to be measured can be any 
point along the other side of the angle 
(or the endpoint of the segment). Press 
e to select the third point. The 
angle measure will appear with the 
hand. Move it to a convenient location 
away from the angle. Press C to 
turn off the hand. Press C again to 
exit the angle measure tool.

5 

Move the pointer to an endpoint of one 
of the sides. Press a to activate 
the hand. Use : ; to change the 
angle measure.

6 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

ACTIVITY OVERVIEW:

In this activity we will

• Draw an angle
• Find the measure of the angle
• Change the angle

We can use our knowledge of naming angles as we learn about measuring 
angles with the measurement tool. We can also review classifying angles as we 
change the angle measure to obtain acute, right, or obtuse angles.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric 
shapes and develop mathematical arguments about geometric relationships.

Drawing and Measuring an Angle
Approximate

Total Time:
25 minutes
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ACTIVITY OVERVIEW:

In this activity we will

• Draw a segment
• Draw its perpendicular bisector
•  Measure the two halves of the segment
• Measure an angle formed
•  Change the length and position of the segment

After drawing a segment and its perpendicular bisector, we are able to observe 
right angles and congruent segments. In addition, we can see that changing the length 
or orientation of the segment will also change the perpendicular bisector.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric 
shapes and develop mathematical arguments about geometric relationships.

1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 
Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2 and choose 
Segment to draw a line segment. 
Move the pencil to the desired location 
of one endpoint of the segment and 
press e. Move to the location of 
the other endpoint and press e.

Press # and move to Perp. Bis. 
then press e. Move the big arrow 
until the segment is fl ashing. Press 
e and the perpendicular bisector 
is drawn.

3 

 Press @ for F2 and choose 
Point then move right and down 
to Intersection and press e. 
Move until both the segment and 
the perpendicular bisector are 
both fl ashing and press e; the 
intersection point will be marked.

4 

 Now you can measure each half of 
the segment and an angle formed 
by the intersection of the segment 
and the perpendicular bisector. The 
measurement tools are found in the 
F5 menu.

5 

Press a and grab an endpoint 
of the segment to change its length 
and position. You will be able to see 
the measurements of the segments 
change as the segment changes 
length and position. The angle will 
remain 90°.

For TI-NavigatorTM Users

Use Screen Capture to observe and 
assess individual progress in drawing 
and exploring. For help, see page 56. 

6 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Perpendicular Bisector 
of a Line Segment Approximate

Total Time:
20 minutes
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1 

Press A. Move down to the CabriJr 
APP and press e. Press ! for 
the F1 menu and select New. (If asked 
to Save changes? press < e to 
choose “No.”) Press e, or any key, 
to begin using the application.

2 

Press @ for F2, move down to 
Triangle and press e.

3 

Move to the location of a vertex and 
press e. Move to the second 
vertex and press e. Move to the 
third vertex and press e. Press 
C to exit the triangle drawing tool.

4 

Press % for the F5 menu and 
move down to Alph-Num and press 
e. When the text cursor is near 
vertex A and the point is blinking, press 
e m e to label vertex A. 

For TI-NavigatorTM Users

 Use Screen Capture to identify 
problems with labeling. For help, see 
page 56. 

5 

Move the cursor to vertex B and when 
the point is blinking, press e A 
e to label vertex B. Move to vertex 
C and when the point is blinking, press 
e p e to label vertex C. 

6 

Use F5 to measure each angle. When 
you have measured angle A, use 
the hand to move the number to a 
convenient location. Press C then 
measure angle B. Repeat for angle C.

7 

Press % for F5 and move down 
to Calculate. Press e. Move the 
arrow until an angle measure has a 
fl ashing underline and press e. 
Repeat this until the measures for all 
three vertices are fl ashing. Press + 
and the sum of the angle measures 
will be displayed.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a triangle
• Label the vertices
• Measure the interior angles
• Find the sum of the angles
•  Change the angles of the triangle

This activity provides a wonderful opportunity for discovery and conjecture about 
the sum of the angles in a triangle. It could also be used to reinforce a previous lesson 
about triangles and their interior angles.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric 
shapes and develop mathematical arguments about geometric relationships.

Measuring Angles in a Triangle
Approximate

Total Time:
30 minutes
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8 

Press C C to disable the 
hand and to exit the calculate tool. 
Move to a vertex and when it is 
fl ashing, press  a. Use the hand 
to move the vertex and record what 
happens to the angle measures and 
their sum. Move to a different vertex 
and explore changes there.

9 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

10 

Based on their observations, students 
will be able to make a conjecture about 
the sum of the measures of the angles 
of a triangle.

Measuring Angles in a Triangle
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1 

Press A. Move down to the CabriJr 
APP and press e. Press ! for 
the F1 menu and select New. (If asked 
to Save changes? press < e to 
choose “No.”)

2 

Press @ for F2 and press ; 
e to select Line. Press e to 
mark one point on the line. Move the 
pointer : and > several times and 
press e to mark the other point 
defi ning the line.

3 

The Line tool is still active so press 
e again to mark this point as 
one of the points that will determine 
another line. Press ; to move away 
from that point and press e to 
mark the other point on the new line. 
Press C to disable the Line tool.

4 

Use F5 to measure the angle formed 
by the 3 marked points. Move the 
angle measure to a convenient 
location and press C to deactivate 
the hand.

5 

The Angle Measure tool is still 
active so now mark points forming 
the other vertical angle. You will fi rst 
mark a point on one line, move to the 
intersection point, then mark a point 
on the second line. When the angle 
measure is displayed it can be moved 
to a convenient location. Press C 
to deactivate the hand.

6 

Move the pointer to one of the marked 
points which defi ned a line. Press 
a to grab the point.

7 

Move the point left or right to change 
the angles formed. Observe that the 
measures of the vertical angles both 
change as the angle changes.

ACTIVITY OVERVIEW:

In this activity we will

• Draw two intersecting lines
• Measure one pair of vertical angles
• Move a line to change the angles
• Observe the changes in the angle measures

In this activity we are able to visualize and explore the angles that are formed when 
two lines intersect. By measuring the angles, we can enhance our understanding of 
vertical angles, supplementary angles, and a linear pair.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric 
shapes and develop mathematical arguments about geometric relationships.

Intersecting Lines and 
Vertical Angles

Approximate
Total Time:
20 minutes
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8 

Extension: Measure the other angles 
formed by the intersecting lines. Which 
angles are congruent? Which angles 
are supplementary?

9 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Intersecting Lines and 
Vertical Angles
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application.

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2, move to Line 
and press e. Move down and to 
the left and press e to mark one 
point on the line. Move to the right and 
press e to mark the second point 
defi ning the line.

3 

Press # for F3, move to Parallel, 
and press e. Move the pencil until 
the line is blinking. Press e then 
press : until the second line is in the 
desired location. Press e to mark 
the point through which the parallel 
line is drawn.

4 

Press @ for F2 and select Line. 
Move up and mark a point by pressing 
e. Move down and left and press 
e to mark the second point 
defi ning the transversal of the two 
parallel lines.

Now we will measure angles and 
explore angle relationships.

5 

Press % for F5. Move down to 
Measure, then right and down to 
Angle then press e. You must 
select three points to identify the angle. 
Move the pencil until one of the lines 
is fl ashing and press e to select 
a point on that line. Move the pencil 
until one of the parallel lines and the 
transversal are both fl ashing and press 
e. This will mark their intersection 
as the vertex of the angle. Move the 
pencil to the other line forming a side 
of the angle. Press e when that 
line is fl ashing. Move the measurement 
to a convenient location. Press C 
to turn off the hand.

ACTIVITY OVERVIEW:
In this activity we will

• Draw parallel lines
• Draw a transversal
• Explore angle relationships

We can develop and strengthen our knowledge about the angles formed when parallel lines are cut by a transversal. 
The measurement tool helps us discover the relationships between and among the various angles in the fi gure.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric 
shapes and develop mathematical arguments about geometric relationships.

Parallel Lines Cut 
By A Transversal

Approximate
Total Time:
30 minutes

Geometry.indb   11Geometry.indb   11 3/6/06   3:53:43 PM3/6/06   3:53:43 PM



12 Texas Instruments Incorporated Getting Started with Geometry • cabrijr.com

6 

With the angle measuring tool active, 
measure some of the other angles 
formed—corresponding, alternate 
interior, alternate exterior…

Move each measurement to a 
convenient location. Press C to 
turn off the hand.

7 

Move the pointer to one of the points 
which defi ned the location of the 
transversal. Press a to activate 
the hand and move this point. Observe 
the angle measures as the position of 
the transversal changes.

8 Extensions 

Move the transversal until one of the 
angles has “crossed over” and observe 
that you now have consecutive interior 
angles that are supplementary.

9 

Measure the remaining angles and 
observe the relationships among the 
angle measures.

For TI-Navigator™  Users

 Activity Center: Load a background 
image of parallel lines cut by a 
transversal with angles named. Instruct 
students to move their cursors to: the 
interior, the exterior, to an angle with a 
specifi c characteristic (congruent to a 
given angle, supplementary to a given 
angle, …).

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Parallel Lines Cut 
By A Transversal
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for the F2 menu, move 
to Segment, and press e. Move 
the pencil to the desired location of 
the fi rst endpoint of the segment and 
press e. Move right to the desired 
location of the second endpoint and 
press e.

Press #, move to Perp. Bis., and 
press e to access the tool. Move 
the pencil until it becomes an arrow 
and the segment is fl ashing. Press 
e and the perpendicular bisector 
is drawn.

3 

Press @ for the F2 menu, move 
to Point, move right and down to 
Point on and press e. Move the 
pencil until the perpendicular bisector 
is fl ashing, and press e.

4 

Press @, move to Segment, 
and press e. Move the pencil 
until the point drawn on the bisector 
is fl ashing and press e. Move to 
one of the segment endpoints, and 
once it is fl ashing, press e. Now 
create another segment between the 
point on the perpendicular bisector 
and the other endpoint. (The distance 
from the endpoints to the point on 
the perpendicular bisector can be 
measured without the segments, but 
they provide a better illustration of the 
distance measured.)

5 

Press % for F5. Move down to 
Measure, move right to select D. 
& Length, and press e. Move 
the pencil near one of the segments 
and when it is dashed and fl ashing, 
press e. The hand is active and 
the measurement can be moved to a 
convenient location. Press e to 
place the measurement and deactivate 
the hand.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a line segment

• Draw the perpendicular bisector

•  Investigate the distance between a point on the
perpendicular bisector and endpoints of the 
segment.

By using the drawing and measurement tools of Cabri Jr., we can illustrate the concept of 
“equidistant from the endpoints of a segment.” We can move a point on the perpendicular bisector 
and observe the changes that occur.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric 
shapes and develop mathematical arguments about geometric relationships.

Points on the Perpendicular Bisector
of a Segment

Approximate
Total Time:
20 minutes
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6 

The measurement tool is still active and 
you can now measure the distance from 
the point on the perpendicular bisector 
to the other endpoint of the segment. 
Move the pencil to the other segment 
and press e w when it is fl ashing. The 
new measurement appears and can 
be placed where desired by pressing 
e. Press C to deactivate the 
measurement tool.

7 

Move the arrow near the point on the 
perpendicular bisector. When the point 
is fl ashing, press a to activate 
the hand. Move the point up to a new 
location on the perpendicular bisector 
and observe the changes in the 
measurements of the distances to the 
endpoints.

8 

Move the point down to a new 
location on the perpendicular bisector 
and observe the changes in the 
measurements of the distances to the 
endpoints.

9 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

10 

AB ≅ BQ and PQ ⊥ AB

Conjecture: Any point on the 
perpendicular bisector of a line 
segment is _______________ from 
the endpoints of the segment.

Points on the Perpendicular Bisector
of a Segment
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2, move down to 
Triangle and press e. Move to the 
location of a vertex and press e. 
Move to the second vertex and press 
e. Move to the third vertex and 
press e. Press C to exit the 
triangle drawing tool.

3 

Press # for the F3 menu, move 
to Angle Bis., and press e. 
Move the pencil until one side of the 
triangle is fl ashing then press e. 
This marks a point on the side of the 
triangle. Move until the vertex point 
fl ashes and press e. Move until 
the other side forming the angle is 
fl ashing and press e again. You 
have used 3 points to identify an 
angle and the angle bisector has been 
drawn.

4 

With the Angle Bis. tool still active, 
press e to select that point again 
OR move to another point on the side 
of the triangle and press e. Move 
to the next vertex point and press 
e, then move to a point on the 
other side forming the angle and press 
e.

5 

With the Angle Bis. tool still active, 
press e to select that point again 
OR move to another point on the side 
of the triangle and press e. Move 
to the remaining vertex point and press 
e, then move to a point on the 
other side forming the angle and press 
e. Press C to exit the Angle 
Bis. tool.

6 

What appears to be true about the 
intersection of the bisectors of the 
angles of the triangle?

(They appear to intersect at a common 
point.)

Move to a vertex of the triangle, press 
a to activate the hand and move 
the vertex to a new location.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a triangle
•  Draw the bisector of each angle of the triangle
• Locate the incenter
• Explore properties of the incenter

In this activity we will observe a special characteristic of the bisectors of the angles in a triangle. 
We will be able to test our conjecture by changing the size and shape of the triangle.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric 
shapes and develop mathematical arguments about geometric relationships.

Incenter of a Triangle
Approximate

Total Time:
30 minutes
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7 

Press C to deactivate the hand 
and move to a different vertex of the 
triangle. Press a and move the 
point at this vertex.

What appears to be true about the 
intersection of the bisectors of the 
angles of the triangle?

8 

Press C to deactivate the hand 
and move to a different vertex of the 
triangle. Press a and move the 
third point defi ning the triangle.

What appears to be true about the 
intersection of the bisectors of the 
angles of the triangle?

9 

The bisectors of the angles of the 
triangle intersect at a common point. 
This point is called the incenter of the 
triangle.

For TI-Navigator™  Users

You may wish to save this fi le and 
send it to students as an APP VAR for 
exploration and investigation in Activity 
12. For help, see page 74.

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Incenter of a Triangle

Geometry.indb   16Geometry.indb   16 3/6/06   3:53:52 PM3/6/06   3:53:52 PM



Getting Started with Geometry • cabrijr.com Texas Instruments Incorporated  17

1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for the F2 menu, move 
down to Triangle and press e. 
Move to the location of a vertex and 
press e. Move to the second 
vertex and press e. Move to the 
third vertex and press e. Press 
C to exit the triangle drawing tool.

3 

Press # for the F3 menu and 
move down to Perp. Bis.  and press 
e. Move the arrow until one side of 
the triangle is selected (fl ashing) and 
press e. The Perp. Bis. tool is still 
active, so move to another side of the 
triangle and press e when the side 
is fl ashing. Repeat for the third side of 
the triangle. Press C to exit the 
Perp. Bis. drawing tool.

4 

What appears to be true about the 
intersection of the perpendicular 
bisectors of the sides of the triangle?

(They appear to intersect at a common 
point.)

Move to a vertex of the triangle, press 
a to activate the hand and move 
the vertex to a new location. 

5 

Press C to deactivate the hand 
and move to a different vertex of the 
triangle. Press a and move the 
point at this vertex.

What appears to be true about the 
intersection of the perpendicular 
bisectors of the sides of the triangle?

6 

Press C to deactivate the hand 
and move to a different vertex of the 
triangle. Press a and move the 
third point defi ning the triangle.

What appears to be true about the 
intersection of the perpendicular 
bisectors of the sides of the triangle?

ACTIVITY OVERVIEW:

In this activity we will

• Draw a triangle
• Draw the perpendicular bisector of each side
• Locate the circumcenter
• Explore properties of the circumcenter 

What happens when you draw the perpendicular bisectors of all three sides of a triangle? 
Does the same thing occur in any triangle? We can fi nd answers to these questions as we 
develop an understanding of the circumcenter of a triangle.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional 
geometric shapes and develop mathematical arguments about geometric relationships.

Exploring the Circumcenter
of a TriangleApproximate

Total Time:
30 minutes
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7 

The perpendicular bisectors of the 
sides of the triangle intersect at a 
common point. This point is called the 
circumcenter of the triangle.

What is true about the circumcenter of 
an acute triangle? an obtuse triangle? 
a right triangle?

For TI-Navigator™  Users 

You may wish to save this fi le as an 
APP VAR for later exploration and 
investigation. The APPVAR can be 
sent to everyone as you begin Activity 
13. For help, see page 74. 

8 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Exploring the Circumcenter
of a Triangle

Geometry.indb   18Geometry.indb   18 3/6/06   3:53:56 PM3/6/06   3:53:56 PM



Getting Started with Geometry • cabrijr.com Texas Instruments Incorporated  19

1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2, move down to 
Triangle and press e. Move to the 
location of a vertex and press e. 
Move to the second vertex and press 
e. Move to the third vertex and 
press e. Press C to exit the 
triangle drawing tool.

3 

Press # for the F3 menu, move 
to Perp., and press e.  Move 
the pencil to a vertex and when it is 
fl ashing, press e. Move the arrow 
to the side opposite the vertex and 
when it is fl ashing, press e. This 
will draw a line through the vertex and 
perpendicular to the opposite side.

4 

With the Perp. tool still active, move 
until the pencil is near another vertex. 
When the point is fl ashing, press e 
then move so that the opposite side is 
fl ashing and press e. 

5 

With the Perp. tool still active, move 
until the pencil is near the third vertex. 
When the point is fl ashing, press e 
then move until the opposite side is 
fl ashing and press e. Press C 
to exit the Perp. drawing tool.

For TI-Navigator™  Users

Use Screen Capture to observe and 
assess individual progress in drawing 
and exploring. For help, see page 56.

6 

What appears to be true about the 
intersection of the altitudes of the 
triangle?

(They appear to intersect at a common 
point.)

Move to a vertex of the triangle, press 
a to activate the hand and move 
the vertex to a new location.

7 

Press C to deactivate the hand 
and move to a different vertex of the 
triangle. Press a and move the 
point at this vertex.

What appears to be true about the 
intersection of the altitudes of the 
angles of the triangle?

ACTIVITY OVERVIEW:

In this activity we will

• Draw a triangle
• Draw the altitudes of the triangle
• Locate the orthocenter
• Explore properties of the orthocenter

Do you know how to construct a line perpendicular to a given line and through a given point? 
This activity is a great companion to that construction as we use the Cabri Jr. tools to draw altitudes in a triangle.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric 
shapes and develop mathematical arguments about geometric relationships.

Exploring the Orthocenter 
of a Triangle

Approximate
Total Time:
30 minutes
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8 

Press C to deactivate the hand 
and move to a different vertex of the 
triangle. Press a and move the 
third point defi ning the triangle.

What appears to be true about the 
intersection of the altitudes of the 
angles of the triangle?

9 

The altitudes of a triangle intersect at a 
common point. This point is called the 
orthocenter of the triangle.

What is true about the orthocenter of 
an acute triangle? an obtuse triangle? 
a right triangle?

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Exploring the Orthocenter 
of a Triangle
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for the F2 menu, move 
down to Circle, and press e. 
Press e to mark the center of the 
circle, then move the pencil to indicate 
the length of the radius, and press 
e to complete the circle.

3 

Draw a line through the two points 
which determined the circle. To do this, 
press @ for the F2 menu, move 
to Line, then press e. Move the 
pencil until the point on the circle is 
fl ashing, and press e. Now move 
the pencil until the center of the circle 
is fl ashing, and press e. Press 
C to exit the line drawing tool.

4 

Press @ for F2 and move to 
Point. Move to the right and down 
to select Intersection. Press e. 
Move the pencil until both the line and 
the circle are fl ashing. Press e to 
mark the point which is the intersection 
of the circle and the line. Now we have 
two points on the circle which are the 
endpoints of a diameter.

5 

To measure the circle’s diameter, press 
% for F5 and move down and right 
to select Measure, D. & Length. Press 
e.

6 

Move the pencil until one endpoint of 
the diameter is fl ashing then press 
e. Move to the other endpoint of 
the diameter and when it is fl ashing, 
press e. Press + to see the 
measurement rounded to hundredths. 
The hand is active so you can move 
the measurement to a convenient 
location then press e.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a circle
• Measure the diameter of the circle
• Measure the circumference of the circle
• Calculate the ratio of the circumference to the diameter 

What might we have in common with Archimedes? This exploration into the relationship between 
a circle’s circumference and its diameter will lead us to our own “discovery” of a value for pi. 

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric 
shapes and develop mathematical arguments about geometric relationships.

Exploring the Diameter and 
Circumference of a CircleApproximate

Total Time:
30 minutes
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7 

The Measurement tool is still active 
so now you can fi nd the circumference 
of the circle. Move the pencil until the 
circle is fl ashing. Press e then 
+ to see the circumference rounded 
to hundredths. Move the hand until 
the measurement is in a convenient 
location. Press e. Press C to 
turn off the measurement tool. 

8 

Press % for F5 and move down 
to Calculate. Press e. Move 
the arrow until the circumference 
measurement shows a fl ashing 
underline and press e then /. 
Move the arrow until the diameter 
measurement has a fl ashing underline 
and press e again. The number 
displayed is the ratio of the circle’s 
circumference to its diameter.

9 

To explore this relationship with other 
circles, press C to turn off the 
Calculate tool. Move the arrow until 
the point which defi ned the circle’s 
radius or its center is fl ashing. Press 
a to activate the hand. Grab the 
point and move it to change the size of 
the circle. 

To confi rm that the ratio is still 3.14, 
repeat the Calculate procedure. (It 
is actually being recalculated each 
time the circle changes, but it is 
impossible to tell this since the number 
is unchanging.)

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Exploring the Diameter and 
Circumference of a Circle
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

For TI-Navigator™  Users

 Send an APP VAR: You may have 
saved the fi gure from Activity 8 as an 
APP VAR. If so, send it via 
TI-Navigator, then have students Open 
the fi le to begin the activity with the 
triangle and its angle bisectors already 
drawn. For help, see page 74.

2 

Press @ for F2, move down to 
Triangle and press e. Move to the 
location of a vertex and press e. 
Move to the second vertex and press 
e. Move to the third vertex and 
press e. Press C to exit the 
triangle drawing tool. 

Next you will use the tools in F3 to 
draw the bisector of each angle in the 
triangle.

3 

Press # for the F3 menu, move to 
Angle Bis., and press e. Move the 
pencil until one side of the triangle is 
fl ashing then press e. This marks 
a point on the side of the triangle. 
Move until the vertex point fl ashes and 
press e. Move until the other side 
forming the angle is fl ashing and press 
e again. You have used 3 points 
to identify an angle and the angle 
bisector has been drawn.

4 

With the Angle Bis. tool still active, 
press e to select that point again 
OR move to another point on the side 
of the triangle and press e. Move 
to the next vertex point and press 
e, then move to a point on the 
other side forming the angle and press 
e.

5 

With the Angle Bis. tool still active, 
press e to select that point again 
OR move to another point on the side 
of the triangle and press e. Move 
to the remaining vertex point and press 
e, then move to a point on the 
other side forming the angle and press 
e. Press C to exit the Angle 
Bis. tool. 

ACTIVITY OVERVIEW:

In this activity we will

• Draw a triangle
• Draw the bisector of each angle of the triangle
• Locate the incenter
• Find the distance from the incenter to a side of the triangle
• Inscribe a circle in the triangle

In Activity 8 we bisected the angles of a triangle and found the incenter of the triangle. How far is it from 
the incenter to each side of the triangle? We will use this distance as the radius of a circle with center at the 
incenter as we inscribe a circle in a triangle.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric shapes 
and develop mathematical arguments about geometric relationships.

Inscribing a Circle in a Triangle
Approximate

Total Time:
25 minutes
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 6 

The bisectors of the angles of the 
triangle intersect at a common point. 
This point is called the incenter of the 
triangle and it is equidistant from the 
sides of the triangle. The incenter is 
also the center of the circle inscribed 
in the triangle. In the next steps we 
will fi nd the distance from the incenter 
to a side of the triangle and use this 
distance as the radius of a circle with 
its center at the incenter. 

7 

Press # for the F3 menu, move to 
Perp., and press e. Move to the 
incenter (two of the angle bisectors will 
be fl ashing indicating that you want 
their intersection) and press e. 
Move the arrow to a side of the triangle 
and press e. You now have a line 
through the incenter and perpendicular 
to one of the sides of the triangle.

8 

Press @ for the F2 menu, move 
to Circle, and press e. Move the 
pencil until the incenter is fl ashing 
and press e. Move the pencil 
until you are at the intersection of the 
side and the line perpendicular to it. 
Press e when both are fl ashing 
to a draw a circle with its center at the 
incenter and with a radius determined 
by the perpendicular distance from the 
incenter to the side of the triangle. This 
is the inscribed circle.

9 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Inscribing a Circle in a Triangle
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

For TI-Navigator™  Users 

 Send an APP VAR: You may have 
saved the fi gure from Activity 9 as an 
APP VAR. If so, send it via 
TI-Navigator, and then have students 
Open the fi le to begin the activity 
with the triangle and its circumcenter 
already located. For help, see 
page 74.

2 

Press @ for F2, move down to 
Triangle and press e. Move to the 
location of a vertex and press e. 
Move to the second vertex and press 
e. Move to the third vertex and 
press e. Press C to exit the 
triangle drawing tool.

3 

Press # for the F3 menu and 
move down to Perp. Bis. and press 
e. Move the arrow until one side 
of the triangle is selected (fl ashing) 
and press e. The Perp. Bis. tool 
is still active, so move to another side 
of the triangle and press e when 
the side is fl ashing. Repeat for the 
third side of the triangle. Press C 
to exit the Perp. Bis. drawing tool.

4 

The perpendicular bisectors of the 
sides of any triangle intersect at a 
common point. This point is called 
the circumcenter of the triangle and is 
equidistant to the vertices. This point 
is also the center of the circumcircle 
of the triangle. This is the circle with 
its center at the circumcenter and a 
radius equal to the distance from the 
circumcenter to a vertex.

5 

Press @ for F2, move down to 
Circle and press e. Move the 
pencil until two of the perpendicular 
bisectors are fl ashing and press e. 
This will mark the circumcenter of the 
triangle as the center of the circle you 
are drawing. Move the pencil until 
a vertex point is fl ashing and press 
e. Press C to turn off the 
Circle tool.

6 

Move to a vertex, press a, 
and observe the changes in the 
circumcenter and the circle as you 
move the vertex.

7 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

ACTIVITY OVERVIEW:

In this activity we will

• Draw a triangle
• Draw the perpendicular bisector of each side
• Locate the circumcenter
• Find the distance from the circumcenter to a vertex of the triangle
• Draw the circumcircle of the triangle.

How far is it from the circumcenter of a triangle to each vertex of the triangle? This distance determines the 
radius of a special circle that we will draw using the circumcenter as the center of the circle.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric shapes 
and develop mathematical arguments about geometric relationships.

Circumscribing a Circle 
About a Triangle

Approximate
Total Time:
20 minutes
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2, move down to 
Triangle and press e. Press e 
to mark the fi rst vertex of a triangle. 
Move the cursor several times to the 
right and press e to mark the 
second vertex. Move the cursor straight 
up several times and press e to 
mark the third vertex of the triangle.

3 

Since the triangle was drawn using 
only moves to the right and up, it 
should be a right triangle. This can 
be supported by using the angle 
measuring tool in the F5 menu as 
shown in the next steps.

4 

Press % for the F5 menu, move 
down to Measure. Move right and 
down to Angle and press e. To 
measure an angle you will select three 
points. As in naming an angle, the 
second point will be the vertex of the 
angle. Each of the other two points can 
be a vertex or any point on the side of 
the side of the triangle.

5 

Move the pencil until a side of the 
triangle is fl ashing, then press e 
to mark a point on the side. Move the 
pencil until the vertex of the angle 
to be measured is fl ashing. Press 
e. Move the pencil until a second 
side is fl ashing. Press e to mark 
the third point naming the angle. The 
measurement of the interior angle is 
displayed and the pointer changes to a 
hand. Use the arrow keys to move the 
measurement to a convenient location. 
Press C to deactivate the hand.

6 

Press # for the F3 menu, move 
down to Midpoint and press e. 
Move the arrow until the hypotenuse 
is fl ashing and press e. Press 
@ for the F2 menu, move down 
to Segment and press e. Move 
the pencil until the midpoint of the 
hypotenuse is fl ashing and press e. 
Move until the vertex point of the right 
angle is fl ashing and press e. 

7 

Next we measure the lengths of the 
segments drawn from the midpoint of 
the hypotenuse to each vertex. Press 
% for the F5 menu and move down 
to Measure and right to D. & Length. 
Press e. Move to one endpoint of 
the hypotenuse and press e. Move 
to the midpoint of the hypotenuse and 
press e. Move the measurement to 
a convenient location.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a right triangle
• Find the midpoint of the hypotenuse
• Measure the distances from the midpoint of the 

hypotenuse to each vertex
• Make a conjecture about these distances

In this activity, we will review defi nitions of terms such as right triangle, hypotenuse, midpoint, 
vertices, and equidistant. We will then discover an important characteristic of the midpoint of the hypotenuse.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional 
geometric shapes and develop mathematical arguments about geometric relationships.

Investigating Segments
in a Right Triangle Approximate

Total Time:
20 minutes
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8 

The Measurement tool is still active, 
so repeat the process above until you 
have the measurements for the other 
two segments (from the midpoint to a 
vertex). 

Based on the measurements, what 
appears to be true about the distance 
from the midpoint of the hypotenuse of 
a right to each of the vertices?

9 

The midpoint of the hypotenuse of a 
right triangle is equidistant from the 
vertices of the triangle.

Test this conjecture by moving 
the vertices at the acute angles to 
change the lengths of the sides of the 
triangles. (Be careful not to change the 
right angle.)

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Investigating Segments
in a Right Triangle
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2, move down to 
Triangle and press e. Move to the 
location of a vertex and press e. 
Move to the second vertex and press 
e. Move to the third vertex and 
press e. Press C to exit the 
triangle drawing tool.

3 

Press # for the F3 menu, move 
down to Midpoint and press e. 
Move the arrow until a side of the 
triangle is fl ashing and press e. 
Move until another side of the triangle 
is fl ashing and press e.

4 

To draw the segment joining the two 
midpoints, press @, move down 
to Segment, and press e. Move 
the pencil until one midpoint is fl ashing 
and press e. Move the pencil 
until the other midpoint is fl ashing and 
press e. 

5 

Press % for the F5 menu to 
measure the length of the segment 
joining the two midpoints. Move down 
to Measure and right to D & Length. 
Press e. Move the arrow until 
the segment joining the midpoints 
is fl ashing. Press e. Press + 
to see the measurement rounded to 
hundredths. Move the measurement 
to a convenient location. Press 
C to turn off the hand. With the 
measurement tool still active, move 
until the third side of the triangle is 
fl ashing and press e. Press + for 
hundredths. Move the measurement to 
a convenient location. Press C to 
turn off the hand. Press C again to 
exit the measurement tool.

6 

How does the length of the segment 
joining the midpoints of two sides of 
a triangle compare to the length of 
the third side? Test this conjecture on 
other triangles by moving to a vertex, 
pressing a, changing the position 
of the vertex, and observing the 
changes in the measurements of the 
segments.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a triangle
• Find the midpoints of two sides of the triangle
• Draw and measure the segment joining the 

midpoints of these two sides
• Compare the length of this segment to the

 length of the third side of the triangle

If you connect the midpoints of two sides of a triangle, you have drawn a midsegment of the triangle. 
How does the length of this segment relate to the third side of the triangle? What if you draw a different midsegment?

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric shapes 
and develop mathematical arguments about geometric relationships.

Investigating Lengths of Segments
in a Triangle

Approximate
Total Time:
20 minutes
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7 

“The measure of the segment joining 
the midpoints of two sides of a triangle 
is one-half the measure of the third 
side.”

8 

Test the conjecture using different 
sides of the triangle.

For TI-Navigator™  Users 

Use Screen Capture to observe 
and assess individual progress in 
drawing and exploring. For help, see 
page 56.

9 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Investigating Lengths of Segments
in a Triangle
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2, move down to 
Triangle and press e. Move to the 
location of a vertex and press e. 
Move to the second vertex and press 
e. Move to the third vertex and 
press e. Press C to exit the 
triangle drawing tool.

3 

Press # for the F3 menu, move 
down to Midpoint and press e. 
Move the arrow until a side of the 
triangle is fl ashing and press e. 
Move until another side of the triangle 
is fl ashing and press e.

4 

To draw the segment joining the two 
midpoints, press @ for F2, move 
to Segment and press e. Move 
the pencil until one midpoint is fl ashing 
and press e. Move the pencil 
until the other midpoint is fl ashing and 
press e. How does the length of 
the segment joining the midpoints of 
two sides of a triangle compare to the 
length of the third side?

5 

Press % for the F5 menu to 
measure the length of the segment 
joining the two midpoints. Move down 
to Measure and right to D & Length. 
Press e. Move the arrow until 
the segment joining the midpoints 
is fl ashing. Press e. Press + 
to see the measurement rounded to 
hundredths. Move the measurement 
to a convenient location. Press 
C to turn off the hand. With the 
measurement tool still active, fi nd 
the measure of the third side of the 
triangle. Press C to exit the 
measurement tool.

6 

How does the slope of the line 
containing the segment joining the 
midpoints compare to the slope of the 
third side?

Press % for F5 and move to 
Measure then right and down to 
Slope. Press e. Move the arrow 
until the segment joining the midpoints 
is fl ashing. Press e then + to view 
it rounded to hundredths. Move the 
measurement to a convenient location 
then press C to turn off the hand. 

7 

With the Slope tool still active, move 
to the third side of the triangle. Press 
e when the side is fl ashing. Press 
+ to view the measurement rounded 
to hundredths. Move the measurement 
to a convenient location then press 
C to turn off the hand. Press 
C again to turn off the Slope tool.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a triangle
• Find the midpoints of two sides
• Draw a segment to join the midpoints 
• Explore the relationships between the 

segment and the third side of the triangle— 
their lengths and the slopes of the lines containing the segments

In the previous activity, we investigated the midsegments of a triangle. We will continue exploring these 
segments and extend our understanding of the relationships that exist by examining the slopes of lines containing the segments.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric shapes 
and develop mathematical arguments about geometric relationships.

Investigating Segments
in a Triangle Approximate

Total Time:
25 minutes

Geometry.indb   30Geometry.indb   30 3/6/06   3:54:18 PM3/6/06   3:54:18 PM



Getting Started with Geometry • cabrijr.com Texas Instruments Incorporated 31

8 

“The segment joining the midpoints of 
two sides of a triangle is parallel to the 
third side and has measure equal to 
one-half the measure of the third side.”

Test this conjecture on other triangles 
by moving to a vertex, pressing 
a, changing the position of the 
vertex, and observing the changes in 
the slopes and measurements of the 
segments.

9 

Further test these conjectures using 
different sides of the triangle.

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Investigating Segments
in a Triangle
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2, move down to 
Triangle and press e. Move to the 
location of a vertex and press e. 
Move to the second vertex and press 
e. Move to the third vertex and 
press e. Press C to exit the 
triangle drawing tool.

3 

To draw the medians we must fi rst 
locate the midpoints of the sides. 
Press # for the F3 menu, move 
down to Midpoint and press e. 
Move the arrow until a side of the 
triangle is fl ashing and press e. 
Move until another side of the triangle 
is fl ashing and press e. Move until 
the third side of the triangle is fl ashing 
and press e. 

4 

Now we will draw the medians of the 
triangle. To draw a segment from a 
vertex to the midpoint of the opposite 
side press @ for F2. Move to 
Segment and press e. Move the 
pencil until a vertex is fl ashing and 
press e. Move the pencil until 
the midpoint of the opposite side is 
fl ashing and press e w.

5 

With the Segment tool still active, 
draw the other two medians of the 
triangle. 

When all three medians are drawn, 
press C to turn off the segment 
tool.

For TI-Navigator™  Users 

Use Screen Capture to observe and 
assess individual progress in drawing 
and exploring. For help, see page 56.

6 

The medians of the triangle intersect 
at a common point. This point is called 
the centroid of the triangle.

To mark this point, press @ for 
the F2 menu. Move to Point, then 
right and down to Intersection. Press 
e. Move the pencil until two of the 
medians are fl ashing then press e. 
How does the length of the segment 
from a vertex to the centroid compare 
to the length of the segment from the 
centroid to the midpoint?

ACTIVITY OVERVIEW:

In this activity we will

• Draw a triangle
• Draw the medians of the triangle
• Locate the centroid
• Explore measures of the segments in the triangle

The median of a triangle is a line segment drawn from one vertex to the midpoint of the opposite 
side of the triangle. What happens when we draw all three medians of a triangle?

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric shapes 
and develop mathematical arguments about geometric relationships.

Exploring the Centroid
of a Triangle

Approximate
Total Time:
25 minutes
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7 

Press % for the F5 menu. Move 
to Measure and D. & Length. Press 
e. Move to a vertex and press 
e when the point is fl ashing. 
Move to the centroid and press e 
when the point is fl ashing. Press + to 
display the measurement rounded to 
hundredths. Move the measurement 
to a convenient location then press 
C to turn off the hand.

8 

Move the pencil until the centroid 
fl ashes. Press e. Move until the 
midpoint is fl ashing and press e. 
Press + to display hundredths. Move 
the measurement, press C to turn 
off the hand, and then press C to 
exit the measurement tool.

9 

It appears that the segment from 
the vertex to the centroid is twice 
the length of the segment from the 
centroid to the midpoint.

Test this conjecture by changing the 
triangle. Move to a vertex and press 
a when the point is blinking. Move 
the point and observe the changes in 
the measures of the segments.

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Exploring the Centroid
of a Triangle
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1 

Press A. Move down to the CabriJr 
APP and press e. Press ! for 
the F1 menu and select New. (If asked 
to Save changes? press < e to 
choose “No.”)

2 

Press @ for F2, move down to 
Quad. and press e. Move to the 
location of a vertex and press e. 
Move to the second vertex and press 
e. Move to the third vertex and 
press e. Move to the fourth vertex 
and press e. Press C to exit 
the quadrilateral drawing tool.

3 

Press # for the F3 menu, move down 
to Midpoint and press e. Move the 
arrow until a side of the quadrilateral 
is fl ashing and press e. Move 
until another side of the quadrilateral is 
fl ashing and press e. Move until a 
third side of the quadrilateral is fl ashing 
and press e. Move until the fourth 
side of the quadrilateral is fl ashing and 
press e.

4 

To draw the segments joining the 
midpoints of adjacent sides, press 
@, move to Segment and press 
e. Move the pencil until one midpoint 
is fl ashing and press e. Move the 
pencil until the midpoint of an adjacent 
side is fl ashing and press e. 

5 

With the same midpoint fl ashing, press 
e to begin a new segment. Move 
the pencil until the midpoint of the next 
side is fl ashing and press e. Press 
e again with that same midpoint 
fl ashing and move to the fourth 
midpoint and press e. For the last 
segment, press e with the fourth 
midpoint fl ashing. Move to the original 
midpoint and press e. Press 
C to turn off the midpoint tool.

6 

What appears to be true about the 
quadrilateral formed by connecting the 
midpoints?

Move the arrow to a vertex of the 
original quadrilateral. When the point is 
fl ashing, press a. Grab the vertex 
and move it to change the shape of 
the original quadrilateral. Observe 
changes in the quadrilateral formed by 
the midpoints. 

7 

The quadrilateral formed by joining 
the midpoints appears to be a 
parallelogram. We can test this 
conjecture by showing that both pairs 
of opposite sides are congruent. Press 
% to use the Measure and D. & 
Length tool from the F5 menu. Move 
the pencil until one side of the fi gure 
is fl ashing and press e. Repeat 
to fi nd the measurements for the 
remaining sides of the quadrilateral.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a quadrilateral
• Find the midpoints of the sides
• Draw segments to join the midpoints of 

adjacent sides
• Explore characteristics of the shape formed

What are the properties of the shape formed by connecting the midpoints of adjacent sides of a quadrilateral? 
How can we use our knowledge of geometry, along with the tools of CabriJr, to support our conjectures about the shape?

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric shapes 
and develop mathematical arguments about geometric relationships.

Investigating Segments
in a Quadrilateral

Approximate
Total Time:
30 minutes
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8 

We can also test the conjecture by 
showing that one pair of opposite 
sides is parallel and congruent. In the 
previous step we showed opposite 
sides congruent, so now we must 
test their slopes. Press % for F5 
and move to Measure then right and 
down to Slope. Press e. Move 
the pencil until one side of the fi gure 
is fl ashing and press e. Repeat to 
fi nd the slope of the opposite side of 
the quadrilateral. Press C to exit 
the Slope tool.

9 

Test this conjecture on other 
quadrilaterals by moving to a vertex 
of the original quadrilateral. When 
the vertex point is fl ashing, pressing 
a, change the position of the 
vertex, and observe the changes in the 
measurements of the segments and 
the slopes.

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Investigating Segments
in a Quadrilateral
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2, move to 
Quadrilateral and press e. Move 
to the location of a vertex and press 
e. Move to the second vertex and 
press e. Move to the third vertex 
and press e. Move to the fourth 
vertex and press e. Press C 
to exit the quadrilateral drawing tool.

3 

Press % for the F5 menu, move 
down to Measure. Move right and 
down to Angle and press e. To 
measure an interior angle you will 
select three points. As in naming an 
angle, the second point will be the 
vertex of the angle. Each of the other 
two points can be a vertex of the 
quadrilateral or any point on the side of 
the quadrilateral.

4 

Move the pencil until a side of the 
quadrilateral is fl ashing, then press 
e to mark a point on the side. 
Move the pencil until the vertex of 
the angle to be measured is fl ashing. 
Press e. Move the pencil until a 
second side is fl ashing. Press e to 
mark the third point naming the angle. 
The measurement of the interior angle 
is displayed and the pointer changes 
to a hand. Press + to display the 
angle measurement rounded to tenths. 
Use the arrow keys to move the 
measurement to a convenient location. 
Press C to deactivate the hand.

5 

The angle measurement tool is still 
active, so we will repeat the preceding 
step to fi nd the measure of another 
angle of the quadrilateral. To do this, 
move the pencil until a side is fl ashing. 
Press e to mark a point on that 
side. Move the pencil until the vertex of 
the angle to be measured is fl ashing, 
then press e. Move the pencil 
until a second side is fl ashing. Press 
e to mark the third point naming 
the angle. The measurement of the 
angle is displayed and the pointer 
changes to a hand. Press + to display 
the angle measurement rounded to 
tenths. Use the arrow keys to move the 
measurement to a convenient location. 
Press C to deactivate the hand. 

ACTIVITY OVERVIEW:

In this activity we will

• Draw a quadrilateral
• Find the measure of each interior angle
• Find the sum of the measures of the 

interior angles

This activity allows us to use an interactive, investigative approach to determining the sum of the interior angles 
of a quadrilateral. We will use Cabri Jr. to draw, measure, and calculate as we explore the angles of quadrilaterals.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric shapes 
and develop mathematical arguments about geometric relationships.

Measuring Angles 
in a Quadrilateral

Approximate
Total Time:
25 minutes
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6 

Repeat the preceding step to fi nd the 
measures of the remaining two interior 
angles of the quadrilateral.

Press C to exit the measurement 
tool.

Record the measures of the four 
angles. Find the sum of the angles. In 
the example: 
122.4° + 64.5° + 98.4° + 74.7° = 360°.

7 

Move the arrow until one of the 
vertices of the quadrilateral is fl ashing 
and press a to activate the hand. 
Use the arrow keys to move the vertex 
to form a new quadrilateral.

Record the measures of the four 
angles. Find the sum of the angles. In 
the example: 
139.5° + 68.6° + 77.0° + 74.7° = 360°.

8 

Press C to turn off the hand and 
move the pointer to a different vertex. 
Press a to activate the hand and 
move the vertex to a new location.

Record the measures of the four 
angles. Find the sum of the angles. In 
the example: 
139.5° + 97.4° + 60.7° + 62.4° = 360°.
Make a conjecture: The sum of the 
interior angles of a quadrilateral is 
_______. 

9 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

10 

Note: Sometimes there may be a 
rounding error in the angle measures 
and the sum may not be exactly 360°. 
This is a limitation of the software. 

Also, we did not use the Calculate 
feature of the F5 menu since it allows 
you to add at most 3 values and we 
want the sum of all four interior angles.

Measuring Angles 
in a Quadrilateral
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2, move down to 
Circle and press e. Move to the 
desired location of the center and 
press e. Move to indicate the 
length of the radius and press e. 
Press C to turn off the Circle tool.

3 

Press @ for F2, move to 
Segment and press e. Move the 
pencil until the circle is fl ashing and 
press e to mark one endpoint of a 
chord. Move the pencil until the circle 
is again fl ashing and press e 
to mark the other endpoint of the 
chord. Press C to deactivate the 
Segment tool.

4 

Press # for the F3 menu, move 
to Perp. and press e. Move the 
pointer until the chord is fl ashing and 
press e. Move the pencil until 
the center of the circle is fl ashing 
and press e. This will draw a line 
perpendicular to the chord and through 
the center. Press C to deactivate 
the Perp. tool. What appears to be 
true about the two parts of the chord?

5 

The perpendicular line appears to 
have bisected the chord. To test this, 
we will measure the segments.

Press % for the F5 menu to 
measure the lengths of the two 
segments of the chord. Move down 
to Measure and right to D & Length. 
Press e. Move the pencil until 
one endpoint of the chord is fl ashing. 
Press e. Move the pencil until 
the chord and the perpendicular line 
are fl ashing and press e. This 
displays the segment length and 
marks the intersection of the chord 
and the perpendicular line. Press + 
to see the measurement rounded to 
hundredths. Move the measurement to 
a convenient location. Press C to 
turn off the hand.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a circle
• Draw a chord
• Draw a line perpendicular to the chord 

and passing through the center 
of the circle

• Explore the lengths of the two segments 
of the chord

What is a chord of a circle? What happens if you draw a line perpendicular to the chord and through the center 
of the circle? Will the same thing happen with a different chord? What if you change the size of the circle?

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric shapes 
and develop mathematical arguments about geometric relationships.

Perpendicular Segments
in a Circle

Approximate
Total Time:
20 minutes
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6 

With the measurement tool still active, 
fi nd the length of the other segment 
of the chord. Move until the point 
of intersection of the chord and the 
perpendicular line is fl ashing, then 
press e. Move until the other 
endpoint of the chord is fl ashing and 
press e. Press + to display the 
measure rounded to hundredths. Move 
the measurement to a convenient 
location and press C to deactivate 
the hand. Press C to exit the 
measurement tool. 

7 

It appears that a line which is 
perpendicular to a chord and passes 
through the center of a circle also 
bisects the chord. Test this conjecture 
by changing the length or location 
of the chord. Move the pointer until 
one endpoint of the chord is fl ashing. 
Press a and move the point 
to a different location. Observe the 
changes in the segment measures as 
the chord is moved. You can explore 
this further by changing the size of the 
circle.

8 

Since the line perpendicular to the 
chord passes through the circle’s 
center, it contains a diameter and a 
radius which are also perpendicular 
to the chord. This illustrates part of 
the familiar theorem: In a circle, if a 
diameter or radius is perpendicular to 
a chord, then it bisects the chord (and 
its arc). 

9 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Perpendicular Segments
in a Circle
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2, move down to 
Circle and press e. Move to the 
desired location of the center and 
press e. Move to indicate the 
length of the radius and press e. 
Press C to turn off the Circle tool.

3 

Press @ for F2, move down to 
Segment, and press e. Move the 
pencil until the center of the circle is 
fl ashing and press e. Move the 
pencil until the circle is fl ashing and 
press e. Press C to turn off 
the Segment tool.

4 

Press # for F3, move to Perp. 
and press e. Move the pencil 
until the endpoint of the radius on the 
circle is fl ashing and press e. 
Move until the radius is also fl ashing 
and press e. This draws a line 
through the endpoint on the circle and 
perpendicular to the radius. Press 
C to turn off the Perp. tool.

5 

Move the pointer until the endpoint of 
the radius on the circle is fl ashing and 
press a to turn on the hand. Move 
this endpoint of the radius to a different 
location on the circle and observe 
movement of the line. Press C to 
turn off the hand.

6 

We have drawn a line tangent to the 
circle using the theorem: “In a plane, if 
a line is perpendicular to a radius of a 
circle at its endpoint on the circle, then 
the line is a tangent.” 

7 

You can change the size of the circle 
and observe that the line remains 
tangent at the endpoint of the radius. 

To do this, move the pointer until the 
other point on the circle is fl ashing 
and press a. Move this point to 
change the size of the circle. 

8 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

ACTIVITY OVERVIEW:

In this activity we will

• Draw a circle
• Draw a radius of the circle
• Construct a line perpendicular to the 

radius at its endpoint. This will be a 
tangent line.

“In a plane, if a line is perpendicular to a radius of a circle at its endpoint on the circle, then the line is a tangent.”

We can use this theorem and our skills with the drawing tools of Cabri Jr. to draw a line tangent to a circle.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional geometric shapes and 
develop mathematical arguments about geometric relationships.

Drawing a Line
Tangent to a Circle

Approximate
Total Time:
20 minutes
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

Press @ for F2, move down to 
Circle and press e. Move to the 
desired location of the center and 
press e. Move to indicate the 
length of the radius and press e. 
Press C to turn off the Circle tool.

3 

We will mark two points along the “top” 
of the circle to determine a minor arc 
of the circle.

Press @ for F2, move to Point, 
then right to Point and press e. 
Move the pencil until the circle is 
fl ashing and press e to mark a 
point on the circle. Move the pencil 
until the circle is fl ashing again and 
press e to mark a second point on 
the circle. 

4 

Now we will mark two more points 
along the “bottom” of the circle. Each 
of these points will be the vertex of an 
inscribed angle.

The Point tool is still active, so move 
until the circle is fl ashing and press 
e. Move the pencil until the circle 
is again fl ashing and press e. 
Press C to turn off the Point tool.

5 

Now we will name the points that 
determine the arc.

Press % for F5, move to Alph-
Num, and press e. Move the text 
cursor until one of the two points of the 
arc is fl ashing and press e. Press 
m (for the alpha character A) then 
press e. Move the text cursor until 
the other point of the arc is fl ashing 
and press e. Press A (for the 
alpha character B), then press e. 
We now have AB.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a circle
• Mark two points on the circle to determine an arc
• Mark two points to be the vertices of inscribed angles
• Observe the relationship between the inscribed angles

This activity gives us the opportunity to investigate angles inscribed in a circle. 
By drawing and measuring certain angles, we can establish the relationship between angles that intercept the same arc.

NCTM Geometry Standard: Analyze characteristics and properties of 2- and 3-dimensional 
geometric shapes and develop mathematical arguments about geometric relationships.

Inscribed Angles Intercepting
The Same ArcApproximate

Total Time:
30 minutes
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6 

Now we will name the points that will 
be the vertices of the inscribed angles.

The Alph-Num labeling tool is still 
active, so move to one of the points 
along the “bottom” of the circle. When 
the point is fl ashing, press e p 
e. Move the text cursor to the 
other point that you placed along the 
“bottom” of the circle and press e 
i e. Press C to turn off the 
Alph-Num tool.

7 

Next we will draw segments that will 
form the sides of the inscribed angles.

Press @, move to Segment, and 
then press e. Move the pencil until 
the point at A is fl ashing and press 
e. Move until the point at D is 
fl ashing and press e. You should 
now see AD.

With point D still fl ashing, press e 
to begin a new segment. Move until 
the point at B is fl ashing and press 
e. 

8 

With point B still fl ashing, press e 
to begin a new segment. Move until 
the point at C is fl ashing and press 
e. With the point at C still fl ashing, 
press e to begin a new segment. 
Move until the point at A is fl ashing and 
press e. Press C to turn of 
the Segment tool.

9 

∠BCA and ∠BDA are inscribed 
angles that intercept the same arc. 
What appears to be true about these 
angles?

These angles appear to be congruent.

We can use the measurement tool to 
fi nd their measures.

10 

Press % for the F5 menu, move 
down to Measure. Move right and 
down to Angle and press e. To 
measure an angle you will select three 
points. As in naming an angle, the 
second point will be the vertex of the 
angle. Each of the other two points 
can be one of the labeled points or any 
point on a side of the angle.

11 

We will fi rst fi nd the measure of ∠BCA. 

Move the pencil until the point at B 
is fl ashing, then press e. Move 
the pencil until the vertex of the angle 
to be measured, the point at C, is 
fl ashing. Press e. Move the pencil 
until the point at A is fl ashing. Press 
e to mark the third point naming 
the angle. The measurement of the 
inscribed angle is displayed and the 
pointer changes to a hand. Press + 
to display the angle measurement 
rounded to tenths. Use the arrow 
keys to move the measurement to a 
convenient location. Press C to 
deactivate the hand.

12 

The Angle measurement tool is still 
active so now we will fi nd the measure of 
∠BDA.

Move the pencil until the point at B 
is fl ashing, then press e. Move 
the pencil until the vertex of the angle 
to be measured, the point at D, is 
fl ashing. Press e. Move the pencil 
until the point at A is fl ashing. Press 
e to mark the third point naming 
the angle. The measurement of the 
inscribed angle is displayed and the 
pointer changes to a hand. Press + 
to display the angle measurement 
rounded to tenths. Use the arrow 
keys to move the measurement to a 
convenient location. Press C to 
deactivate the hand. Press C to 
turn off the Angle tool.

Inscribed Angles Intercepting
The Same Arc
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13 

The inscribed angles have the same 
measure. This illustrates the theorem: 
“If inscribed angles intercept the same 
arc (or congruent arcs), then the 
angles are congruent.”

To further explore this, move the 
pointer until the point at A is fl ashing, 
press a, and move the point. 
Press C to turn off the hand. 

You can observe that as the arc 
changes, the measures of the 
inscribed angles change, but stay 
equal to each other.

14 

You can explore this further by moving 
any of the points A, B, C, or D. Move 
until the desired point is fl ashing, press 
a, then move the point to a new 
location. Press C to turn off the 
hand. Repeat the steps to move a 
different point.

For TI-Navigator™  Users 

Use Screen Capture to check students’ 
progress. For help, see page 56.

15 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Inscribed Angles Intercepting
The Same Arc
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1 

Press A. Move down to the CabriJr 
APP and press e. Press ! for 
the F1 menu and select New. (If asked 
to Save changes? press < e to 
choose “No.”)

2 

Press @ for F2, move to Line 
and press e. Move to the desired 
location and press e to mark one 
point on the line. Move the pencil to 
the desired location of the other point 
defi ning the line and press e. 

3 

Press # for the F3 menu, move 
Parallel and press e. Move until 
the line is fl ashing and press e. 
Move the pencil to a new location to 
mark a point through which the parallel 
line will pass, then press e.

4 

Press # for the F3 menu, move 
Perp. and press e. Move until 
the original line is fl ashing and press 
e. Move the pencil to a new 
location to mark a point through which 
the perpendicular line will pass, then 
press e.

5 

How are the slopes of these lines 
related?

Press % for F5 and move to 
Measure then right and down to 
Slope. Press e. Move the arrow 
until one line is fl ashing and press 
e. Move the measurement to a 
convenient location then press C 
to turn off the hand. With the Slope 
tool still active, move until another line 
is fl ashing and press e. Move the 
measurement to a convenient location 
then press C to turn off the hand. 
The Slope tool is still active so move 
to the third line is fl ashing and press 
e. Move this measurement and 
press C to turn off the hand. 

6 

The parallel lines have the same 
slopes, but the perpendicular lines 
do not. To explore the relationship 
between the slopes of the 
perpendicular lines, we can fi nd the 
product of their slopes.

Press % for the F5 menu and 
move to Calculate then press e.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a line
• Draw a line parallel to the original line
• Draw a line perpendicular to the original line
• Explore the relationships between the slopes 

of parallel and perpendicular lines

How are the equations of parallel and perpendicular lines related? The drawing and measurement tools 
allow us to set the stage for investigation as we explore the slopes of lines.

NCTM Geometry Standards: Analyze characteristics and properties of 2- and 3-dimensional geometric shapes 
and develop mathematical arguments about geometric relationships. Specify locations and describe spatial 
relationships using coordinate geometry and other representational systems.

Investigating the Slopes of
Parallel and Perpendicular Lines

Approximate
Total Time:
25 minutes
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7 

Move until one of the slope values has 
a fl ashing underline then press e. 
Move until the slope of a perpendicular 
line has a fl ashing underline and press 
e. At this time, both of the slope 
values should be fl ashing. Press * 
and the product of these slopes will 
be displayed. Move this value to a 
convenient location and press C 
to turn off the hand. Press C again 
to turn off the Calculate tool.

8 

Move the pointer to the fi rst point 
marked on the original line. Press 
a to activate the hand and move 
the point around the screen. Since the 
parallel line and the perpendicular line 
were drawn with respect to the original 
line, they will both move as you move 
the point on the original line. Observe 
the changes in the slopes and in the 
product. Press C to deactivate the 
hand. 

9 

When using the Calculate tool, 
rounding errors may occur. To display 
the values rounded to hundredths, 
move until the value has a fl ashing 
underline and press +. Repeat this for 
the remaining values. (This can also 
be done when the slope values are 
originally found by pressing + when 
the hand is on the value.)

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Investigating the Slopes of
Parallel and Perpendicular Lines
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

To show the axes, press % for the 
F5 menu, move to Hide/Show, and 
then move right and down to Axes. 
Press e.

3 

Move until the origin is fl ashing and 
press a to activate the hand. 
Move the origin until the axes are 
positioned as shown in the fi gure.

Press C to deactivate the hand.

4 

To draw a triangle in the fi rst quadrant, 
press @ for the F2 menu. Move 
to Triangle and press e. Move the 
pencil to the desired location of one 
of the vertices and press e. Move 
to a second vertex and press e. 
Move to the third vertex and press 
e. Press C to turn off the 
Triangle tool.

5 

Press %  for the F5 menu, move 
to Coord. & Eq, and then press 
e. Move until a vertex is fl ashing 
and press e. The coordinates of 
that vertex are displayed and can be 
moved to a convenient location. Press 
C to deactivate the hand. Move 
until another vertex of the triangle is 
fl ashing and then press e. Use 
the hand to move the coordinates, 
then press C. Move until the third 
vertex is fl ashing and press e. 
Move the coordinates then press 
C to deactivate the hand. Press 
C again to turn off the Coord. & 
Eq. tool.

6 

To refl ect the triangle across the 
y-axis, press $ for the F4 menu, 
move to Refl ection, and then press 
e. Move until all sides of the 
triangle are fl ashing and press e. 
Move until the y-axis is fl ashing and 
press e. Press C to turn off 
the Refl ection tool.

ACTIVITY OVERVIEW:

In this activity we will

• Draw a triangle
• Find the coordinates of the triangle
• Reflect the triangle across the y-axis
• Find the coordinates of the reflected triangle
• Explore the relationship between the original 

coordinates and the coordinates of the reflected triangle

This activity provides a wonderful opportunity to blend coordinate geometry with our experience using drawing tools. 
We can visualize symmetry and refl ecting a point across the y-axis.

NCTM Geometry Standards: Specify locations and describe spatial relationships using coordinate geometry and 
other representational systems. Apply transformations and use symmetry to analyze mathematical situations.

Refl ecting a Triangle in the
Coordinate Plane

Approximate
Total Time:
40 minutes
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7 

Press %  for the F5 menu, move 
to Coord. & Eq, and then press 
e. Find the coordinates of the 
vertices of the refl ected triangle using 
the same procedure as when fi nding 
the coordinates of the vertices of the 
original triangle.

8 

What can you conclude about the 
coordinates of a fi gure when it is 
refl ected across the y-axis?

It appears that the coordinates (x, y) 
becomes (-x, y) in the refl ected image.

Test this conjecture by changing the 
original triangle. Move until a vertex is 
fl ashing, press a, and then move 
the point. Observe the changes in the 
coordinates of the vertices of both 
triangles.

9 

Press C to deactivate the hand. 
Move until all three sides of the original 
triangle are fl ashing and press a. 
Move the triangle and observe the 
changes in coordinates.

For TI-Navigator™  Users 

Activity Center: Load a background 
image of a triangle in Quadrant 1. 
Have students mark a point on the 
triangle then mark a second point 
which is the image of the fi rst point 
refl ected across the y-axis. For help, 
see page 64.

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Refl ecting a Triangle in the
Coordinate Plane
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1 

Press A. Move down to the CabriJr 
APP and press e. Press e, or 
any key, to begin using the application. 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press < e to choose “No.”)

2 

To show the axes, press % for the 
F5 menu, move to Hide/Show, and 
then move right and down to Axes. 
Press e.

3 

Press @ for F2, move to Line 
and press e. Move until the y-axis 
is fl ashing and press e at some 
location on the axis to mark the 
y-intercept of the line. Move to the right 
and up and press e. This marks 
the second point that defi nes the line.

4 

Press % for the F5 menu, move 
to Coord. & Eq. and press e. 
Move until the line is fl ashing and 
press e. The equation of the line 
is displayed and can be moved to a 
convenient location. Press C to 
deactivate the hand. Press C 
again to turn of the Coord. & Eq. tool.

5 

Move until the point (not on the y-axis) 
is fl ashing and press a. Move the 
point up and down and observe the 
changes in the equation of the line. 

The slope of the line changes as the 
point moves. The y-intercept stays 
constant since it was one of the two 
points used to defi ne the line.

6 

Press C and move until the 
y-intercept is fl ashing. Press a 
and move the point up and down on 
the axis. Observe that the y-intercept 
and the slope both change as the point 
is moved. 

7 

Draw another line using two more 
points, neither of which is the 
y-intercept of the new line. To do this 
press @ for F2, move to Line 
and press e. Move to a location in 
the second quadrant and press e. 
Move to a location in the fi rst quadrant 
and press e. This marks the 
second point that defi nes the line.

ACTIVITY OVERVIEW:
In this activity we will

• Draw a line and find its equation
• Move the points defining the line 

and observe the changes in the equation
• Draw another line and observe changes 

in its equation

We can explore the equations of lines written in the form:  y = mx + b. By moving points defi ning the lines, 
we can view the related changes in the parameters of the equations.

NCTM Geometry Standard: Specify locations and describe spatial relationships using coordinate 
geometry and other representational systems.

Investigating Equations
of Lines

Approximate
Total Time:
25 minutes
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8 

To fi nd the equation of the new line, 
press % for the F5 menu, move 
to Coord. & Eq. and press e. 
Move until the new line is fl ashing 
and press e. The equation of the 
line is displayed and can be moved to 
a convenient location. Press C 
to deactivate the hand. Press C 
again to turn of the Coord. & Eq. tool.

9 

Move until the new line is fl ashing and 
press a. Unlike the fi rst line, this 
entire new line can be moved up or 
down keeping the same slope since 
the y-intercept was not one of the 
defi ning points.

You can also use the hand to move 
either of the points used to defi ne the 
line. This will change the slope and the 
y-intercept.

For TI-Navigator™  Users 

Activity Center: Have students submit 
equations with certain characteristics 
(e.g. with a specifi c slope, parallel to a 
given line, with the same y-intercept as 
a given line). For help, see page 69.

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Investigating Equations
of Lines
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ACTIVITY OVERVIEW:

In this activity we will practice

• Accessing the Cabri Jr. application
• Navigating the menus
• Exiting the APP

1 

Turn the calculator ON and press 
A.

2 

Move down the list using ; until you 
fi nd CabriJr. Press e to select 
the application. (Or simply press the 
number to the left of CabriJr.)

Press e, or any key, to begin using 
the application.

3 

Explore the F2 menu by pressing !.

F1 is mainly for fi le management and 
Help.

F2, F3, F4, and F5 are for construction 
tools and options. 

4 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

5 

The keys on the top row of the 
calculator are called “soft keys” when 
using an APP. We will use practice 
using the keys ! @ # $ 
% to access menus in Cabri Jr.

6 

Press @ to access the F2 menu.

This menu is for basic constructions.

7 

Press # to access the F3 menu.

8 

Press $ to access the F4 menu.

9 

Press % to access the F5 menu.

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Exploring the Menus
Cabri™ Jr.

Basic 1

Geometry.indb   50Geometry.indb   50 3/6/06   3:54:56 PM3/6/06   3:54:56 PM



Getting Started with Geometry • cabrijr.com Texas Instruments Incorporated  51

ACTIVITY OVERVIEW:

In this activity we will

• Access the Cabri Jr. application
• Draw points from the F1 menu
• Name and save a file

1 

Turn the calculator ON and press 
A. Move down the list using ; until 
you fi nd CabriJr. Press e to select 
the application. (Or simply press the 
number to the left of CabriJr.) Press 
e, or any key, to begin using the 
application.

2 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press <  e to choose “No.”)

3 

Press @ for the F2 menu. When 
you are on Point in the menu, move 
right to Point, then press e.

4 

Use the arrow keys to move the pencil 
around the screen. Press e each 
time you want to mark a point.

5 

Press ! for the F1 menu and move 
down to Save and press e. Name 
the fi le POINTS by pressing the 8 7 
q l 4 L. (These are the keys 
with the alpha characters for the word 
POINTS.) Press e to save the fi le.

6 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Naming and Saving a File
Cabri™ Jr.

Basic 2
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ACTIVITY OVERVIEW:

In this activity we will

• Access the Cabri Jr. application
• Open the file called POINTS
• Edit and save the file

1 

Turn the calculator ON and press 
A. Move down the list using ; until 
you fi nd CabriJr. Press e to select 
the application. (Or simply press the 
number to the left of CabriJr.) Press 
e, or any key, to begin using the 
application.

2 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press <  e to choose “No.”)

3 

Press ! for the F1 menu, move to 
Open, then press e.

4 

Move to the fi le POINTS and press 
e.

5 

When the fi le opens, press @ for 
the F2 menu. When you are on Point 
in the menu, move right to Point, then 
press e.

Use the arrow keys to move the pencil 
around the screen. Press e each 
time you want to mark a point.

6 

Press ! for the F1 menu, move to 
Save and press e. The fi le has 
been edited and saved with the same 
name.

7 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Opening and Editing a File

Cabri™ Jr.
Basic 3
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ACTIVITY OVERVIEW:

In this activity we will

• Access the Cabri Jr. application
• Draw a point and a line segment
• Practice moving the figures

1 

Turn the calculator ON and press 
A. 

2 

Move down the list using ; until you 
fi nd CabriJr. Press e to select 
the application. (Or simply press the 
number to the left of CabriJr.) Press 
e, or any key, to begin using the 
application.

3 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press <  e to choose “No.”)

4 

Press @ for the F2 menu. When 
you are on Point in the menu, move 
right to Point, then press e. Move 
around the screen and press e to 
mark a point.

5 

Press @ for the F2 menu, move 
to Segment then press e. Move 
the pencil to the location of one 
endpoint of the segment and press 
e. Move to the location of the 
other endpoint and press e. Press 
C to exit the segment drawing 
tool.

6 

Move the arrow until the segment is 
fl ashing and press a. The hand 
will appear and you can move the 
segment to a new location. Press 
a or C to turn off the hand 
and leave the segment in the new 
location.

7 

Move the arrow until the point is 
fl ashing and press a. The hand 
will appear and you can move the 
point to a new location. Press a 
or C to turn off the hand and leave 
the point in the new location.

8 

Move the arrow until one endpoint 
of the segment is fl ashing and press 
a to grab this point with the hand. 
You can change the position of this 
endpoint. (You are moving the point 
rather than the segment.)

9 

Press a or C or e to turn 
off the hand.

10 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Moving Figures
Cabri™ Jr.

Basic 4
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ACTIVITY OVERVIEW:

In this activity we will

• Access the Cabri Jr. application
• Draw some points
• Label each point

1 

Turn the calculator ON and press 
A. 

2 

Move down the list using ; until you 
fi nd CabriJr. Press e to select 
the application. (Or simply press the 
number to the left of CabriJr.) Press 
e, or any key, to begin using the 
application.

3 

Press ! for the F1 menu and select 
New. (If asked to Save changes? 
press <  e to choose “No.”)

4 

Press @ for the F2 menu. When 
you are on Point in the menu, move 
right to Point, then press e. 

5 

Move around the screen using the 
arrow keys and press e to mark a 
point when the pencil is at the desired 
location. Make two more points by 
moving around the screen and 
pressing e at the desired location 
of each point.

6 

Press C to exit the point drawing 
tool.

7 

Press % for the F5 menu and 
move down to Alph-Num and press 
e. Move the text cursor to one of 
the points.

8 

When the text cursor is near one of the 
points and the point is blinking, press 
e m  e to label Point A. 
(You selected m because the alpha 
character associated with that key is 
the letter “A.”)

9 

Move the cursor to another point 
and when the point is blinking, press 
e A e to label point B. 
(You selected A because the alpha 
character associated with that key is 
the letter “B.”)

10 

To label a fi gure with a number rather 
than a letter, press a. Move to 
the third point and when the point is 
blinking, press e 1 e to label 
point 1.

Labeling Points

Cabri™ Jr.
Basic 5
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11 

Press C to exit the labeling tool.

12 

You can change the location of a label.

To move the label “B”, move the arrow 
until the underlined portion of B is 
fl ashing. Press a to engage the 
hand and move the label to the new 
location. Press a or e or 
C when the label is in the desired 
location and the hand will disappear.

13 

To move a point and its label, move 
the arrow until the point is fl ashing and 
press a  to engage the hand. As 
you move around the screen, the point 
and label will move together.

Press a or e or C when 
you reach the desired location and the 
hand  will disappear.

14 

To exit the APP, press ! for the F1 
menu. Move to Quit, then press e. 
(Or you can press ` M for î.)

Labeling Points Cabri™ Jr.
Basic 5

Geometry.indb   Sec1:55Geometry.indb   Sec1:55 3/6/06   3:55:11 PM3/6/06   3:55:11 PM



56  Texas Instruments Incorporated Getting Started with Geometry • cabrijr.com

USING SCREEN CAPTURE 

Overview 

This tour details the use of Screen Capture in the TI-NavigatorTM software and covers the following areas 

1. Capturing screens from entire class 

2. Refreshing screens 

3. Capturing screens from one or more students 

1. Launch the TI-Navigator Software 

 Click Start > Programs > TI Tools > TI-Navigator > TI-Navigator. 

 The TI-Navigator computer home screen opens. 

2. Start a Class 

 Assure that your TI-Navigator™ network hardware is connected and powered and calculators containing the necessary apps are connected. 

 Choose a Class to begin in the Current Class selector and click Begin Class.

Using Screen Capture

TI-Navigator
Tips
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3. Open the Tools Tab and launch the Screen Capture tool 

 A. Click the Tools tab near the upper middle of the home screen. 

 B. Click the Screen Capture icon. 

4. Select Students 
A. Default setting will be to collect screens from the entire class; however 

you can also select to collect specific students’ screens. 

 • To select the entire class click on the Class Icon 

 • To select specific students click on the Student Icon

B. Click the OK button. 

Using Screen Capture
TI-Navigator

Tips
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C. The Screen Capture window opens and student screens are collected. 

5. Refresh Student Screens
 Click on the Refresh to capture a fresh set of student screens. 

Using Screen Capture

TI-Navigator
Tips
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USING QUICK POLL 

Overview 

This tour details the use of Quick Poll in the TI-NavigatorTM system and covers the following areas 
1.  Sending Quick Poll to students 
2.  Viewing poll summary 
3.  Showing student names 
4.  Sending poll results to students 

1. Launch the TI-Navigator Software 

 Click Start > Programs > TI Tools > TI-Navigator > TI-Navigator. 
 The TI-Navigator computer home screen opens. 

2. Start a Class 
 Assure that your TI-Navigator™ network hardware is connected and powered and calculators containing the necessary apps are connected. 

 Choose a Class to begin in the Current Class selector and click Begin Class. 

Using Quick Poll
TI-Navigator

Tips
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3. Open the Tools Tab and launch the Quick Poll tool 
 A. Click the Tools tab near the upper middle of the home screen. 

 B. Click the Quick Poll icon. 

 The Quick Poll window opens. 

4. Select Type of Poll  
 A. There is a variety of polling question types you can send, including:  

  -Agree/Disagree 

  -Yes/No 

  -True/False 

  -Right/Wrong 

  -Always/Sometimes/Never 
  -Multiple Choice 

  -Open Response 

 B. Select the type of poll to send to class from the Drop-down list. 

Using Quick Poll

TI-Navigator
Tips
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5. Start Poll 
 A. Click on the Start Poll button. 

 The poll opens on students calculators. 

 B. Students submit their answers by pressing Send. 

6. View Student Responses 
 A. To view poll results graphically click the Poll Summary Tab. 

Using Quick Poll
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 B. To view poll results in a table click the Poll Details Tab. 

7. Other Poll Options 
 A. To allow students to change their selection, click the Resubmit check box. 

 Note: Resubmit must be selected before starting the poll. 

 B. To send poll results to students click the Send Results button. 

 The results will be sent to each student’s calculator. 

To view 
show student 
Display 
Names click 
the Show 
Student 
Names check 
box

Using Quick Poll
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 C. If you want to temporarily keep students from responding to a poll, click the Pause Poll button. 

Using Quick Poll
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CONTRIBUTING POINTS IN ACTIVITY CENTER 

Overview 

This tour details the use of Points in Activity Center and covers the following areas 
1.  Selecting Contributing Points for Student Input  
2.  Configuration Options for Contributing Points 
3.  Starting Activity 
4.  Changing Appearance of Student Cursors  

1. Launch the TI-Navigator™ Software 
 Click Start > Programs > TI Tools > TI-Navigator > TI-Navigator. 

 The TI-Navigator computer home screen opens. 

2. Start a Class 
  Assure that your TI-Navigator™ network hardware is connected and powered and 

calculators containing the necessary apps are connected. 

 Choose a Class to begin in the Current Class selector and click Begin Class. 

3. Open the Tools Tab and launch the Activity Center 
 A. Click the Tools tab near the upper middle of the home screen. 

 B. Click the Activity Center icon. 

Contributing Points 
in Activity Center
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 The Activity Center opens. 

4. Select Type of Input for Student 
 Select Points from the Drop-down list. 

5. Defi ne Confi guration settings for Contribute Point Activity
 A. Click on the Confi gure button.

Contributing Points 
in Activity CenterTI-Navigator
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 B. Select Confi guration for Point Activity. 

 C. Click Start Activity to allow students to enter the Activity Center and begin contributing their data. 

6. Have students login, enter the Activity Center and contribute data. 
 A. Students login and chose ACTIVITY CENTER from the TI-NAVIGATOR HOME screen. 

 Note: If you have not started the Activity, students will see the following screen. 

With the Main 
Settings you can 
select how many 
points for your 
student to drop, 
the step size the 
student’s cursor will 
move, and the lists 
that the X and Y 
coordinates will be 
stored in 

If you select that 
students will submit 
points all at once, 
their cursors will 
not appear on the 
screen until they 
submit all of the 
points. 

Contributing Points 
in Activity Center
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 The Activity Center will open.  

 B. The student will be able to move their cursor point around the screen.  

 C. Students data will appear on the teacher computer. 

7. Select unique cursors for each student 
 Click View → Individualize Student Cursors. 

Contributing Points 
in Activity CenterTI-Navigator
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 Student cursors will change to unique colors and shapes.

Contributing Points 
in Activity Center
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CONTRIBUTING EQUATIONS IN ACTIVITY CENTER 

Overview 

This tour details the use of Equations in Activity Center, including: 
1. Selecting Contributing Equations for Student Input  
2. Configuration Options for Contributing Equations 
3. Starting Equation Activity 
4. Viewing Equation data 

1. Launch the TI-NavigatorTM Software 
 Click Start > Programs > TI Tools > TI-Navigator > TI-Navigator. 

 The TI-Navigator computer home screen opens. 

2. Start a Class 
 Assure that your TI-NavigatorTM network hardware is connected and powered and calculators containing the necessary apps are connected. 

 Choose a Class to begin in the Current Class selector and click Begin Class. 

3. Open the Tools Tab and launch the Activity Center 
 A. Click the Tools tab near the upper middle of the home screen. 

 B. Click the Activity Center icon. 

Contributing Equations 
in Activity CenterTI-Navigator
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The Activity Center opens. 

 C. Click the Graph-Equation Tab. 

 The Graph-Equation view will open. 

Contributing Equations 
in Activity Center
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4. Confi gure and start the Contribute Equations Activity 
 A. Click Equations from the Contribute selector. 

 B. Click the Confi gure button. 

 The Confi gure Calculators for Activity dialog box will open. 

 Click OK. 

 C. Click Start Activity to allow students to enter the Activity Center and begin contributing their data. 

Contributing Equations 
in Activity CenterTI-Navigator
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5. Have students login, enter the Activity Center and contribute data 
 A. Students login and chose ACTIVITY CENTER from the TI-NAVIGATOR HOME screen. 

 Note: If you have not started the Activity, students will see the following screen. 

 The Activity Center will open. 

 B. Students enter equations.

 C. Because Let students view graphs of equations was enabled, students may choose to Plot (π)their data on their calculators. 

Contributing Equations 
in Activity Center
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 D. Students Send (ο) their data to the Activity Center on the teacher computer. 

 The data appear in the Graph-Equation view. 

 E. Click on any one equation to highlight it in the Graph screen. 

Click the Show 
Student Names 
option to 
display student 
names beside 
the equations 
they have 
contributed. 

Click and drag 
the frame 
between the 
Graph screen 
and Equation 
Gallery to 
enlarge the 
viewable area for 
equations. 

Contributing Equations 
in Activity CenterTI-Navigator
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SENDING FILES 

Overview

This tour details starting a class, sending a fi le to all students and viewing 
the transfer action in the Class Record. 

1. Launch the TI-NavigatorTM Software 
 Click Start > Programs > TI Tools > TI-Navigator > TI-Navigator. 

 The TI-Navigator computer home screen opens. 

2. Start a Class 
 Assure that your TI-NavigatorTM network hardware is connected and powered and calculators containing the necessary apps are connected. 

 Choose a Class to begin in the Current Class selector and click Begin Class. 

3. Queue a fi le to be sent 
 Click Tools > Send to Class. 

 The fi rst Send dialog box (Step 1) will open. 

Sending Files
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 Browse to a valid device fi le, select it and click Next. 

 The fi nal Send dialog box (Step 2) will open. 

 Choose one or more student(s) to receive the fi le. 

 Click Finsh. 

You can hold the 
Shift or Ctrl key to 
select multiple fi les.

Choose Force 
Send to have 
student’s 
automatically 
begin receiving 
the fi le on 
their devices 
immediately. 

Sending Files
TI-Navigator
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4. Select the Send Action in the Class Record 
 Click the Send Action that you just created in the Class Record. 

 If it is not already selected, click the Classroom Tab. 

 If it is not already selected, choose Seating Chart in the Classroom View selector. 

 A Seating Chart view of your class will open. 

  Notice that the students’ icons to who have received the fi le are highlighted in green. Those to whom the fi le was sent but have not yet  
received it have red-highlighted icons. If the fi le was not sent to a student, their icon will not be highlighted (not shown in this example).  

Sending Files

TI-Navigator
Tips

Geometry.indb   76Geometry.indb   76 3/6/06   3:55:22 PM3/6/06   3:55:22 PM



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


